Technical Document 2659
September 1993

Graphics MIS/Shop
Store Program
User's Manual

E. R. Ratliff

Approved for public release; distribution is unlimited.
Technical Document 2659
September 1993

Graphics MIS/Shop Store Program
User’s Manual

E. R. Ratliff
ADMINISTRATIVE INFORMATION

This document was prepared by the Technical Information Division using in-house funding.

Released by
E. R. Ratliff
Associate for Automation
and Systems Management

Under authority of
M. E. Cathcart, Head
Technical Information
Division

<table>
<thead>
<tr>
<th>Accession For</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>NTIS</td>
<td>CRA&amp;I</td>
<td></td>
</tr>
<tr>
<td>DTIC TAB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unannounced</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Justification</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>By</th>
<th>Distribution/</th>
<th></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Availability Codes</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Dist</td>
<td>Avail and/or Special</td>
<td></td>
</tr>
</tbody>
</table>

P-1
Contents

Chapter 1. The MIS/Shop Store Program ................................................................. 1
Conventions ........................................................................................................... 1
What is The MIS/Shop Store Program? .............................................................. 1
Contents of This Manual .................................................................................. 1
The Management Information System .......................................................... 2
Management Information System Terms ..................................................... 2
The Shop Store ..................................................................................................... 4
Shop Store Terms ................................................................................................ 5
Program Setup ..................................................................................................... 6
Installing the Applicable Programs ................................................................... 6
Installing FoxPro ................................................................................................. 6
Installing the MIS/Shop Store Program Files .................................................. 6
Recording Information ...................................................................................... 7
Menus .................................................................................................................... 7
Confirmation Prompts ....................................................................................... 7
Data Entry Screens ............................................................................................. 8
Setting Up the MIS/Shop Store Program ........................................................... 8
The Setup Menu ................................................................................................... 8
Administrative Information .............................................................................. 9
Enter Initial Stock Information ...................................................................... 10
Set up Kits ........................................................................................................... 10
View Total Shop Store Charges ........................................................................ 11
Check for Outdated Products .......................................................................... 11
Restock Inventory ............................................................................................... 11
Employee Options ............................................................................................. 12
Set Clock On/Off ............................................................................................... 13
Print Options ...................................................................................................... 13
Change Fiscal Year ............................................................................................ 13
Change Date ....................................................................................................... 13
Database Administrator .................................................................................... 13
Backup/Restore ................................................................................................... 14
Customizing and Modifying the Program .......................................................... 14

Chapter 2. The Main Menu .................................................................................. 15
Accessing the Main Menu .................................................................................. 15
Main Menu MIS Choices .................................................................................. 15
Main Menu Shop Store Choices ....................................................................... 16
Menu Choices Applicable to Both MIS and Shop Store Functions ................. 17

Chapter 3. Recording, Changing, and Deleting Task Information..................... 19
Recording Task Information ............................................................................ 19
Changing (Updating) Task Information ........................................................... 21
Chapter 10. Backup and Restore .......................................................... 43
What You Will Need ........................................................................ 43
Backing Up Files ............................................................................ 43
Restoring Files .............................................................................. 43
Chapter 11. Database Administrator ................................................. 45
Functions ....................................................................................... 45
Start New Transaction Form ......................................................... 45
Reinitialize Transaction Form ....................................................... 45
Re-index Databases ........................................................................ 45
Program Control Databases .......................................................... 45
Print Database Structure ................................................................ 46
Check for Product Errors ............................................................... 46
Index ............................................................................................. 47

Figures
Figure 1. Main Menu .................................................................... 7
Figure 2. Setup Menu .................................................................... 8
Figure 3. Print Menu ..................................................................... 35
Chapter 1. The MIS/Shop Store Program

This chapter describes the Management Information System (MIS) Shop Store Program and provides instructions for program installation, setup, and data entry.

Conventions

This manual uses specific typographic conventions to help you install and use the MIS/Shop Store Program.

<table>
<thead>
<tr>
<th>Type style</th>
<th>Used for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>Command names and text that must be typed exactly as it appears. Type the command and press the Enter key.</td>
</tr>
<tr>
<td>ALL CAPITALS</td>
<td>Directory and file names.</td>
</tr>
<tr>
<td>SMALL CAPITALS</td>
<td>Identifying blanks for data entry and messages displayed on the screen</td>
</tr>
<tr>
<td>italics</td>
<td>General emphasis</td>
</tr>
</tbody>
</table>

What is The MIS/Shop Store Program?

The MIS/Shop Store Program maintains records of graphics work, provides statistical information on that work, and facilitates the use of a small shop store at NCCOSC’s RDT&E Division (NRaD). It consists of application programs running within the FoxPro 2.5 database program and is used in a group that produces graphics products at NRaD. The program features on-screen instructions that lead the operator through most routine tasks associated with the MIS and shop store functions.

The Management Information System (MIS) functions allow you to keep statistical information on graphics work, including types of work, labor expended, and customer costs for the products produced. The shop store functions allow you to maintain material inventory and cost records and produce forms that allow accounting to transfer funds from a customer's account to the shop store account. These funds pay for the material used in the graphics production effort.

This manual provides instructions for using the MIS/Shop Store Program. It does not address the problems and responsibilities of purchasing stock and physically storing and sorting the inventory.

This chapter gives a brief description of how a shop store operates. For information on setting up a shop store, contact accounting personnel. For information on the FoxPro for DOS database program, refer to the FoxPro manuals. The instructions for using the MIS/Shop Store Program assume that FoxPro 2.5 for DOS is installed properly and that the MIS/Shop Store application programs are located in the C:\SHOPSTOR directory. Instructions for installing the MIS/Shop Store application programs are provided later in this chapter.

Contents of This Manual

This manual contains:
A general description of MIS Shop Store functions and terms (chapter 1)

Program installation and setup information and data entry instructions (chapter 1)

Main Menu description (chapter 2)

The manual includes instructions for:

- Recording, changing, and deleting graphics work order (task) information (chapter 3)
- Recording, changing, and deleting material charge transactions (chapter 4)
- Recording labor information (chapter 5)
- Viewing information (chapter 6)
- Printing information (chapter 7)
- Producing shop store transaction forms (chapter 8)
- Creating a cost estimate (chapter 9)
- Backup and restore operations (chapter 10)
- Database administrator functions (chapter 11)

The following information can be provided separately if required:

- Information on the structure of the databases used (appendix A)
- An outline of the program flow (appendix B)
- A copy of the programs used (appendix C)

The Management Information System

Why Use a MIS Program?  A management information system can help you track work in process and report on product costs. The primary benefits of the Graphics MIS system are:

- It provides fast access to administrative and fiscal information regarding a task or a group of tasks.
- It allows you to determine the actual unit cost of a product.
- It maintains information required for organization and employee productivity measurements.

Management Information System Terms

Several MIS terms are defined below:

Work Order.  A work order is a task performed for a customer. In this manual, the term work order is used when discussing tasks. A graphics project may require several separate tasks performed by
several different employees.

**Work Order Number.** A work order number is a unique identifying number for a task. It can be *any combination of alphanumeric characters*, but each task must have a unique work order number. The current work order numbering system used requires that the number include a fiscal year designation, the current month, a sequential job number, and the organizational code for which the work will be accomplished. Use of a work order number allows you to access recorded task information quickly on the MIS.

**Product.** A product is the end item produced for the customer. The MIS allows you to track products and determine actual product costs to the customer. You will record product names for the graphics products you produce before you record any specific task information. Examples of product names are: complex vg (viewgraph), simple vg, complex line art, simple line art, complex poster, simple poster, etc. To differentiate between various levels of effort, you can designate products as simple, complex, routine, or any other designation you wish to use. You will use the Setup Menu to record the names of your products. They will appear as reminders on the bottom of the screen when you are adding new task information.

Material and labor charges to a customer are recorded against the products created under individual tasks. This allows the program to maintain costs involved for each task and to calculate the average cost to a customer for products.

For each task, products can be new, revised, or rerun or a combination of all three. The *new* product involves an original effort or the first effort involved in the production effort. A *revised* product involves work on an already existing product to modify it. A *rerun* product is a duplication of a new or revised product. A task might include production of one original complex viewgraph product and 20 reruns of the same or another product.

All charges to the customer are related to new, revised, or rerun products. You can record up to four product names for each task. You can record any number of new, revised, and rerun products for each product name. Within the scope of a task, the products can be any combination of new, revised, or rerun products.

**Task General Information.** Basic information about each task (customer information, job order number, etc.) is recorded from various forms. Record task information from task forms or logs filled in by employees as described in chapter 3. Once you record initial task information, you will not have to record it again when you record material or labor charges against that task. You can change task information at any time. You can delete task information if you have not recorded any charges against the task being deleted. If you have recorded charges against the task, you can mark the task complete.

**Task Labor Hours.** Labor costs are recorded against specific products and tasks. Record labor hours from time sheets on the last day of each work week as described in chapter 5. The MIS maintains the number and cost of hours recorded against each task. Because labor charges are related to new, revised, or rerun products, you will record illustrator hours for each product identified. If the product for which labor was expended is not listed, you can add it while recording labor. You can also change existing product names as required.
The Shop Store

A shop store works much like a small privately owned store for which customers have charge accounts. It allows you to stock material and provide the material to customers. The MIS/Shop Store Program is used to record the cost of the material and print the form required for accounting to transfer funds from the customer's account to the shop store account. As with any store, you must maintain an inventory. In the MIS Shop Store Program, you can maintain inventory information on up to 35 separate stock items. You can record as many material charges involving these stock items as your disk will hold.

Each time you need to bill a customer for a stocked item, you will use the program to record the billing. The individual material charge information you enter is recorded and saved. Each week (or as directed), you print out a transaction form. It lists each billing you have recorded during the week (or other intervening time period). The form is then signed by the branch supervisor and sent to accounting for processing. Accounting ensures that the individual charge amounts listed on the transaction form are transferred from the customer's account to the shop store account.

Unlike a small privately owned store, you cannot make a profit on shop store items. You must charge the customer exactly what you paid for the stock.

You must have direction from accounting personnel before you undertake to run a shop store. The entire shop store process is not described in this manual, but a general description follows.

Contact accounting personnel for permission to set up a shop store and instructions regarding accounting procedures required. They will provide the proper job order numbers and accounts for shop store operation.

Use the Setup Menu to record or change administrative information, including activity name, organization name, supervisor name, and shop store job order number.

Using a standard stub and the shop store job order number received from accounting, order supplies to be stocked in the shop store. You are limited to 35 individual items. You can stock as many of these items as you like.

Calculate the actual cost of each stock item you will be providing to customers. When you are sure of the actual cost of the shop store supplies, calculate the actual unit-of-issue cost. Use the Main Menu selection $ to calculate this cost if required. If you ordered 100 viewgraph frames and the total cost was $100.00, then the unit-of-issue cost for each frame would be $1.00. Remember: The price you charge a customer for an item must reflect what you paid for the item.

Use the Setup Menu to record the inventory. You will record stock numbers, names, unit of issue, unit cost, and number in stock for all stocked items.

Use the Setup Menu to assign frequently bundled items to kits for ease in billing these items. You can record information for up to 20 kits. Each item included in a kit must be stocked in the inventory.

Record work order number and task information for each task as described in chapter 3. After you have recorded the initial task information for a task, you can record material charge transactions against the products listed for the task.

When stocked items are used in a product, record material charges as described in chapter 4. At the kit selection data entry screen, enter the number of kits used. At the inventory data entry screen,
enter the number of each other inventory item used.

At regular intervals (the end of the week or month), use the Print Menu to print the current transaction form. Note that the transaction form is also written to a file on your disk. Each item or items of material will be listed separately. Have the branch head sign the printed form and send it to appropriate personnel in accounting. Accounting maintains information required to balance these transaction forms against the stubs you have used to order the materials.

Follow all procedures provided by accounting for full tracking of shop store account numbers.

Shop Store Terms

Several shop store terms used in these instructions are defined below.

Inventory. The inventory is the stock you maintain to use in the production effort. The program requires that you use the Setup Menu to record the initial stock quantity available and the unit cost of each stock item. For each item stocked, the program maintains the quantity available based on the number of items you bill to customers. Each time you bill a customer, the inventory quantity is decreased by the number of items billed. When all initial items have been billed, the program requires that you use the Setup Menu to check the inventory before further items can be billed.

Unit Cost. The amount you pay for a stock item is the amount you must charge the customer for that item: your unit cost must be the customer's unit cost. The unit cost is the actual cost of one stocked item (one viewgraph frame, one sheet of film, etc.). You can use the Main Menu selection $ to calculate unit cost. The unit cost is recorded for each item in the inventory. It can be changed only after all items purchased at that price have been billed to customers. Each time you restock an item, you must calculate the unit cost of the restocked items.

Material Charge. A material charge is a database record containing the cost a particular customer must pay for material expended in the production of a specific product. Each charge for a specific amount of material is recorded, along with other identifying information, in a separate database record. For example, if you record that you provided three viewgraph frames and two film sheets to a customer, two material charge transactions will be created. One will list frame information. It will list the customer information, the stock name of the frames, the quantity of frames you provided, the unit cost to the customer for the frames and the total amount to charge the customer for the three frames. The other will list film information. It will list the customer information, the stock name of the film, and the total amount to charge the customer for the two sheets of film. The material charge information stored in these records is used to create the shop store transaction form that is sent to accounting.

Transaction Form. A transaction form lists all of the material charges you have recorded since the last transaction form was printed. Transaction forms are numbered sequentially by the program. The first one you print is number 1.

Transaction Form Number. Each material charge record contains the number of the current transaction form (as displayed on the Main Menu). When you print an original transaction form, that number is increased by one. The next material charge record will contain the new current transaction form number.
Program Setup

The following paragraphs contain installation instructions and describe the Setup Menu. Instructions for recording the initial information required by the program are provided. Before performing the setup, ensure that the FoxPro program is installed properly and that the MIS/Shop Store Program files are located in the C:\SHOPSTOR directory.

Installing the Applicable Programs

Installing FoxPro

Follow manufacturer’s instructions for installing FoxPro for DOS on your hard disk. Modify your autoexec.bat and config.sys files as required.

Installing the MIS/Shop Store Program Files

The MIS/Shop Store Program files must be located in a directory named SHOPSTOR on the hard disk designated as C. Create a directory named SHOPSTOR on your hard disk in your root directory. To do this, return to your root and type:

```bash
cd C:\
```

and press Enter.

At the root directory (C:\) prompt, create the SHOPSTOR directory. Type:

```bash
md shopstor
```

and press Enter.

Place the disk containing the MIS/Shop Store program files in drive a. At the root directory (C:\) prompt, type:

```bash
copy a:*.* c:\shopstor
```

and press Enter.

The program files will be copied to your SHOPSTOR directory. At the root directory (C:\) prompt, type:

```bash
copy a:shop.bat c:\
```

and press Enter.

The batch file used to call the program will be copied to your root directory. You can place this file in another directory as long as the directory is in your path.

Access the MIS/Shop Store Program by typing shop at the root directory prompt and pressing Enter. The Main Menu (figure 1) will be displayed.
Recording Information

Data entry for the MIS/Shop Store Program involves menus, confirmation prompts, and data entry screens. The program was designed to provide on-screen instructions for the operator. Each screen contains either a menu with the CHOICE? prompt displayed, or a box at the bottom of the screen with instructions for proceeding with the current function or exiting the current function.

Menus

When a menu is displayed, select the action you wish to take and press the corresponding letter. You do not have to press Enter after a menu selection. If you press X, you will be returned to the previous menu. Pressing X at the Main Menu will return you to the DOS prompt.

Confirmation Prompts

A confirmation prompt allows you to confirm an action you chose at a menu or data entry screen.
Data Entry Screens

When a data entry screen is displayed, fill in applicable blanks on the screen and press Enter after each blank is filled in. Use the arrow keys or the Enter key to move between blanks if required. Pressing PgDn will exit the current screen. In multiple screens, pressing PgUp will take you back to the first screen. When noted in the instructions at the bottom of a data entry screen, pressing PgUp gives alternate options or information. Always note instructions at the bottom of the data entry screen. The instructions give information regarding required information and exit procedures.

Locating information data entry screens are used to locate a single task or material charge for viewing, changing, deleting, recording labor, or printing. On that screen, type one of the options listed as available. The program will search for items with matching information. When items matching your search entries are found, information on those items will be displayed. You will be prompted to accept the found item for access, keep looking, or exit.

You can type full or partial information (customer name, code, job order number) in several locating information data entry screens. The program will search for items containing the partial information you entered.

Setting Up the MIS/Shop Store Program

Use the Setup Menu before you record any other information. The Setup Menu is shown in figure 2. You must record administrative information (selection A), enter initial stock information (selection C), and record employee information (selection E) before you use the program. You can also use selection K to set up kits after the initial stock information has been recorded. All options available at the Setup Menu are discussed in this chapter.

MIS/SHOP STORE SETUP MENU

A - ADMINISTRATIVE INFORMATION
C - ENTER INITIAL STOCK INFORMATION
   (or correct stocking mistakes)
K - SET UP KITS
G - VIEW TOTAL SHOP STORE CHARGES
F - CHECK FOR OUTDATED PRODUCTS
T - SET CLOCK ON/OFF
P - PRINT OPTIONS
Y - CHANGE FISCAL YEAR
H - CHANGE DATE
D - DATABASE ADMINISTRATOR
B - BACKUP/RESTORE

X - EXIT - RETURN TO MAIN MENU   ? - HELP

Figure 2. Setup Menu

The Setup Menu

At the Main Menu, press S. The Setup Menu will be displayed. All setup functions provide on-screen instructions. This chapter lists detailed instructions for using the functions. The following selections are available at the Setup Menu.
Administrative Information

Some administrative information is required by the program. You must record this information. It can be changed as required.

At the Setup Menu, press A. The administrative information data entry screen will be displayed. Fill in the following blanks. Each blank must be filled in.

**Last Number in Sequence.** If you are doing the initial setup, type 0 in the LAST NUMBER IN SEQUENCE blank. Your first material charge entry will then be number 1. The program increases by one for each item or items of material you record as a material charge. Normally, the operator does not change this number after the initial setup.

**Contra Account.** If you are doing the initial setup, type the number assigned for the contra account by accounting in the CONTRA ACCOUNT blank. This number must be recorded. It is printed on the shop store transaction form.

**Current Transaction Form.** If you are doing the initial setup, type 1 in the CURRENT TRANSACTION FORM blank. This assigns number 1 to your first transaction form. The program will increase this number by one each time you print an original transaction form. Normally, the operator does not change this number after the initial setup.

**Current Fiscal Year.** Type the year designation (1993, 1995, etc.) of the current fiscal year in the CURRENT FISCAL YEAR blank.

**Activity.** Type the name of the facility or command in the ACTIVITY blank.

**Branch Name.** Type the name of your organization or group in the BRANCH NAME blank.

**Branch Code.** Type the number of the organizational code of your group in the BRANCH CODE blank.

**Branch Head.** Type the name of the head of your group in the BRANCH HEAD blank. This name will be printed at the bottom of each transaction form for signature. Ensure that the name of the person who will sign the transaction forms is in this blank.

**Branch Phone.** Type the phone number of the branch head in the BRANCH PHONE blank. This number will be printed at the bottom of each transaction form.

**Shop Store Job Order Number.** Type the number used for receiving transaction transfers in the SHOP STORE JOB ORDER NUMBER blank. This is the job order number provided by accounting.

**Product Types.** Type product names (items that your group produces) in the PRODUCT TYPE blank. The names will be displayed in all caps when you type them in. This is the master list of product names. A product is the end item produced in your group. Examples of product types are complex vg, simple vg, complex lineart, simple lineart, complex poster, simple poster, etc. To differentiate between various levels of effort, you can designate products as simple, complex, routine, or any other designation you wish to use. Later, when you are recording task information you must identify the product produced under each task. The program will accept only products that have been identified as a product type at this screen.

Use of standard product names makes sorting and printing by product name much simpler and ensures a high level of accuracy in statistical information. After initial entry, change these items only to add new products. Do not change the basic nomenclature of a product. For example, if you record simple viewgraph at the screen as one of your products, do not change the entry later to read easy view graphs. After modifying product names, use Setup Menu selection F to check existing tasks for outdated product names. You will be allowed to change product names no longer listed to match names in the current list.
Enter Initial Stock Information

You must enter initial stock information in your inventory before entering any material charge transactions. Use this selection only when entering the initial stock information, adding stock items not previously recorded, or correcting errors made during previous stock information entry. Do not use this selection for changing the number of items available in an existing inventory. The program maintains the numbers required for balancing the existing stock and the stock you have provided to customers. If you change stock items available using this selection, the numbers will not balance.

When entering initial stock information, you must fill in all blanks for each item you stock. Do not record only partial information for an item. If you record a stock number, record also the name of the item, the unit of issue, unit cost, and number in stock.

Stock number. Assign a unique stock number for each item and enter it in the STOCK NUMBER blank. Choose a number that will be easy to identify as that item. For example, 8.5- x 11-inch film manufactured by QMS and provided to the customer in sheets might be given the stock number QMSF851IS. You can name it smallvgframe, largevgfram, qmsregfilm, qmssmallfilm, or another name or abbreviation.

Name of stock item. Assign a stock name that adequately identifies the stock UI (unit of issue). The unit of issue is a 2- or 3-letter designation and should be easily identified. Use ea for each. If an item is provided in sheets, you could use sht. For frames, you could use frm.

Unit Cost. The amount listed is what the customer will be charged for one unit of the material. It must also be the unit cost of that item, which is the amount that you paid for it. For example, if you paid $100.00 for 100 sheets of film, and the unit of issue is ea (each), then the unit cost must be $1.00. The sheets cost you $1.00 each, and you must charge the customer $1.00 each. You cannot charge the customer more or less than what you paid for the item. A shop store is not a profit-making endeavor. Use selection $ at the Main Menu to calculate unit cost/customer price.

In Stock. Enter the number of unit items you purchased. If you purchased 100 sheets of film and are providing them individually to the customer, enter 100. Do not change this number later! The computer will decrease the numbers each time you charge a customer for an item. When the number reaches zero, you will restock the item.

Set up Kits

Kits are groupings of stock items. If you normally provide several items grouped together to customers, set up a kit containing those items. When you bill the customer for the kit, the program will record that you provided the customer with all the items in the kit, and a material charge will be created for each item. You can store information on 20 kits. Remember that each item in a kit must also be listed as a stock item in the inventory. Do not record a kit with only one item in it. Individual stock items should be billed as stock items, not as kits.

When you press K at the Setup Menu, the kit data entry screen will be displayed. Note instructions at the bottom of the screen.

To add a kit, enter a kit part name and the stock numbers and quantities of items in that kit. To delete a kit, delete the kit name. All items contained in that kit will be deleted.

Kit name. Choose a name easily identified as a kit. For example, the kit titled Kit 1 vgsmall might include all items required to produce a letter-sized viewgraph (frame, film, ink) using materials manufactured by various vendors. It can then be identified as Kit 1 or vgsmall. There is enough room to name the kit small viewgraph if you like, or even kit 1 - small viewgraphs in white frames.
Stock Number and Quantity. For each kit, there are blanks for STOCK NUMBER and QUANTITY. You can include up to five stock items in a kit. Enter only inventory stock numbers in the STOCK NUMBER blanks. In the QUANTITY blank, record the quantity of each inventory item that is required to make a kit. For example, Kit 1 might contain two items: one qmsregfilm and one smallygframe.

After you have entered kit information, the program checks to make sure that the stock items in each kit are listed in the inventory. If they are not, an operator message will be displayed. The kit part numbers not listed will be displayed. If an item listed in a kit is also listed in the inventory, but is currently out of stock, a message will be displayed. The next screen will list the kit parts that are currently out of stock.

View Total Shop Store Charges
This selection allows you to view a total of all material charges you have recorded.

Check for Outdated Products
This selection checks all product names recorded for tasks against the master list of product names you recorded at the Setup Menu. If a task product name that does not match one of the master list product names is found, you will be prompted to change it to one of the names contained in the master list.

Restock Inventory
Use Setup Menu selection R to restock the inventory after initial stock information has been recorded and all stock items of a stock number have been used and billed.

To restock, purchase material using the shop store job order number and calculate the price you paid for each item. Then enter the number of items and unit cost for each item. Costs for materials from commercial vendors vary. The price you pay for stock items may go up or down over a period of days or weeks. The price you charge the customer for each item must be determined by the price you paid for the items, so all of the existing stock items in a category must be expended and billed before you restock and record the new unit cost.

There is some stock item loss and destruction during normal operations. You may be physically out of stock, while the program indicates that you still have stock items. For normal stock loss, use an overhead job order number and bill yourself for the remaining items before you enter the number of new stock items and their new unit cost figures.

When you select R at the Setup Menu, an information screen will be displayed. It contains the information listed above. Press Enter.

The restock data entry screen will be displayed. If an item is out of stock (0 in the NUMBER IN STOCK column), you will be able to enter information in blanks for stock number, name of stock item, unit of issue (UI), unit cost, and number of items. To restock an item, enter the new unit cost and the new number in stock. If required, you can modify the stock number of the name of the stock item at this time. Do not record only partial information for a stock number. If you record a stock number, also record the name of the item, the unit of issue, unit cost, and number in stock.

If you change a stock number later, check the kits. If the changed stock number is included in a kit, change that number also.
After the last restock data entry screen, the Kit Option Menu will be displayed. To check or change kit information, press K. The kit data entry screens will be displayed. Use these screens to add or change kit names, stock numbers and quantities of items contained in kits. Remember that kit item stock numbers must be stock items located in the inventory. Again, be sure to read instructions displayed at the bottom of the screens.

**Employee Options**

You must record employee information for each employee in your group at initial setup of the program. At the Setup Menu, press E. The Employee Options Menu will be displayed.

**Adding Employee Information.** To add employee information, press A at the Employee Options Menu. The adding employee information data entry screen will be displayed.

All information requested on the data entry screen is required. In the INITIALS blank, enter three initials by which you will identify the employee when recording task information. Enter the employee's LAST NAME and FIRST NAME in the appropriate blanks. Obtain OVERHEAD RATE and PROJECT RATE (costs per hour) for each employee from your division administrative staff and enter the information in the appropriate blanks. If you leave a blank empty, an error message will be displayed. You will be allowed to return to the data entry screen and correct the error or exit and return to the Employee Options Menu.

**Changing Employee Information.** To change employee information, press C at the Employee Options Menu. The first changing employee information data entry screen with a list of employees and initials will be displayed.

Enter the initials of the employee and press Enter. If the employee information is not found in the database, a message will be displayed.

The second changing employee information data entry screen will be displayed. Use the arrow or return keys to position the cursor in the blank requiring change. Type changes and press Enter.

You cannot record duplicate initials for employees. You must assign and use a unique three-letter initial designator for each employee. If you enter initials already assigned to another employee, an error message will be displayed. The initials will not be changed.

You can change information on the data entry screen, but you cannot delete it. Employee last name, first name, title, overhead rate, and project rate must be recorded for each employee.

**Deleting Employee Information.** To mark an employee as no longer employed, press D at the Employee Options Menu. The deleting employee information data entry screen with a list of employees and initials will be displayed. Note instructions displayed at the bottom of the screen.

Enter the initials of the employee and press Enter. If the employee information is not found in the database, a message will be displayed. If the employee initials are found, you will be prompted to confirm. If you confirm, the employee information will be changed to indicate that the employee is not employed.

**Viewing Employee Information.** To view employee information, press V at the Employee Options Menu. The View Employee Information Menu will be displayed. You can view individual employee information or information on all employees in sequence.

To view information on one employee, press O at the View Employee Information Menu. The employee information data entry screen with a list of employees and initials will be displayed. Note instructions displayed at the bottom of the screen.
Enter the initials of the employee and press Enter. If the employee information is not found in the database, a message will be displayed. If the employee initials are found, the employee information will be displayed.

To view information on all employees, press A at the View Employee Information Menu. Information on each employee will be displayed. Press Enter to move between screens. Press Esc to exit this function and return to the View Employee Information Menu.

Printing Employee Information. To print employee information, press P or R at the Employee Options Menu. Selection P prints a list of employees and initials. Selection R prints a listing of employee initials, names, overhead, and project labor rates. The date the information was added and the date the information was last changed will also be printed for each employee.

Set Clock On/Off

You can display the computer clock in 12- or 24-hour format in the top right corner of each screen. Press T at the Setup Menu. Use the cursor key to position the cursor blank at CLOCK OFF, CLOCK ON, or NO CHANGE and press Enter. If you select CLOCK ON, use the cursor key to position the cursor blank at 12 HOURS or 24 HOURS and press Enter.

Print Options

The Setup Menu Printer Control option allows you to select the computer printer port and the type of printer you are using. At the Printer Control Menu, you can select an Epson dot matrix or a HP Laserjet printer emulation. Select the letter corresponding to the feature desired. If you select a printer port that does not have a printer attached, the messages TURN PRINTER ON TO CHECK STATUS and PRINTER NOT READY will be displayed.

Toggle the Print Labor Option ON if you want a printout of labor hours as you record them.

Change Fiscal Year

Use selection Y to change the fiscal year as required. If you cannot record the current fiscal year, exit the program and check the date function on the computer. To do this, type date and press Enter at the DOS prompt.

Change Date

Use selection H to change the date stored on the computer. Because many program functions rely on the computer date, it is important that the date be current. Also note that a date error on the computer could indicate a battery problem.

Database Administrator

The Database Administrator function is password protected. The functions listed on the Database Administrator Menu include:

- Start new transaction form
- Reinitialize transaction form
- Re-index databases
Direct access to program control databases

Chapter 11 lists detailed information on database administrator functions.

Backup/Restore

The Backup/Restore option allows you to back up the database files to disks in drive a or b or restore previously backed-up files. The program uses the DOS backup utility to allow long files to be written over several disks. You must have a formatted floppy disk available to back up the files. You can use the same backup disks over and over. Mark the backup disks with the date of backup. Chapter 10 lists detailed backup and restore instructions.

Customizing and Modifying the Program

The administrative information that describes the organizational structure of your group and the type of products produced can be modified. The Setup Menu is provided for this purpose. Because a fully functional FoxPro application program is used for the MIS program, the MIS application program files can be changed as required to provide different capabilities and reports. The MIS and shop store functions are performed by complex programs and should be modified only by programmers conversant in the FoxPro programming language. Appendix A lists the database structure, appendix B lists the program flow, and appendix C lists the application programs. These documents can be provided on request.
Chapter 2. The Main Menu

This chapter describes choices available at the Main Menu. The Main Menu includes MIS menu choices, shop store menu choices, and choices applicable to both.

Accessing the Main Menu

The MIS/Shop Store Main Menu is shown in figure 1.

A batch file may be set up to allow access from the DOS prompt. If a batch file named shop.bat has been set up, type shop and press Enter at the DOS prompt. If a batch file has not been set up, you can access the Main Menu by typing FoxPro while in the C:SHOPSTOR directory.

Menu Description. When the Main Menu is displayed, the number of tasks that have been recorded will be displayed at the top of the menu. If you have recorded any material charges, an operator message showing the number of the current transaction form will be displayed. Printer status is shown at the bottom right of the menu. If the printer is off-line or not connected, the PRINTER NOT READY message will be displayed.

The Main Menu consists of MIS menu choices (left side of screen), shop store menu choices (right side of screen), and general menu choices applicable to both (bottom center of screen). These selections are described below.

Main Menu MIS Choices

Enter New Task Information. Each task has a unique work order number. This selection allows you to record basic administrative information about a task (customer information, work order number, job order number, task title, primary illustrator, product produced, classification, start/completion dates, products, comments). Use this selection to record the first task information you obtain from a log or form. After work order number and basic task information has been recorded, you can bill the customer for shop store items used for the task and record labor that has been expended against the task.

Update Information. This selection allows you to change basic administrative and product information for a previously recorded task.

Delete Information. This selection allows you to delete task information. Note that you cannot delete information after it has had labor or shop store charges recorded against it. You can mark such tasks complete by entering a completion date.

Record Labor. This selection allows you to record labor against a task. The hours recorded for each employee can be printed if that option has been set at the Setup Menu.

Mark Task Complete. This selection allows you to mark a task complete from the Main Menu. You can also mark tasks complete while recording labor.

Statistical Information. This selection allows you to view or print product costs.
Main Menu Shop Store Choices

Enter New Material Charge. This selection allows you to record charges to a customer for shop store items. Use this function to charge a customer for material against a work order number that has previously been recorded. The program keeps a record of each charge made to a customer. Information stored for each charge includes customer information, job order information, stock information, and amount of the charge. You will not have to enter this information each time you record a charge.

A separate record is maintained for each material charge to a customer. If you charge one kit to a customer and the kit contains three items, three records will be recorded; one for each item contained in the kit. The number of the transaction form on which the charge will appear is stored with the record. All charges recorded will appear on the current transaction form (as shown on the Main Menu) until you print that form. After the transaction form is printed, charges will appear on the next numbered transaction form. That number will then be shown as the current form number on the Main Menu.

Change Material Charge. This selection allows you to change a material charge if the charge has not already been printed on a transaction form. If the customer has already been billed for the shop store item, the information cannot be changed. Using the change option, you can change the customer information and job order number. You can also change the number of items to be charged on the transaction. For example, you can change the record so that a customer will be billed for four rolls of film instead of two.

Delete Material Charge. This selection allows you to delete a material charge if the charge has not already been printed on a transaction form. Again, if the customer has already been billed for a shop store item, the charge information cannot be deleted.

Transaction Forms (Check/View/Print). This selection accesses the Transaction Forms Menu and allows you to view or print transaction forms. A transaction form lists all material charges recorded since the previous transaction form was printed. Each transaction form has a number, beginning with 1. The current transaction form number is shown at the top of the Transaction Forms Menu.

Before you use Transaction Forms Menu selection P to print the transaction form, use selection V to view the form or selection D to print a draft of the form for review. Normally, the only pending form is the current form. All other forms are assumed to have been printed. However, there may be an occasion where you use the Setup Menu to begin a new transaction form without printing the current one. Use Transaction Forms Menu selection C to see which transaction forms have not been printed.

When you use selection P to print a transaction form that has already been printed, it will be marked duplicate. The first time a transaction form is printed, it will be marked original.

Check Inventory. This selection accesses the Inventory Check Menu. It allows you to view and check the inventory of parts and kits you have recorded. It is important to check your kits periodically to make sure that general inventory parts are available for your kits. You can also use this selection to count the number of sales of a specific item. Selection I displays the names of inventory items that are out of stock. Selection V displays the entire inventory list including stock number, stock name, unit of issue, price, and quantity in stock. Selection P prints the inventory list. Selection T lists the numbers of transaction forms that have not yet been printed. Selection K displays kit names and contents. Selection C displays kit numbers that contain items that are currently out of stock in the inventory. Selection S allows you to display a count of inventory items charged to customers.

Calculate Unit Cost. This selection allows you to perform a simple division operation to calculate the unit cost for inventory items. The program will prompt you to enter the cost of the material, the number of unit items purchased, and the number of items to be provided as a unit of issue. The unit cost will be displayed.
Menu Choices Applicable to Both MIS and Shop Store Functions

Print. This selection accesses the Print Menu. You can print task information or shop store information in several different formats.

View. This selection accesses the View Menu. You can view task information by customer name, code, or work order number; by job order number, or by employee. You can view inventory information, kit information, sales by stock number, and archived transaction forms. You can also view statistical information and the customer and employee lists.

Setup. This selection accesses the Setup Menu and allows you to customize the program for your particular application. It also allows you to record the initial employee, inventory, and kit information required for program operation. The Setup Menu and instructions for program setup are contained in chapter 1.

Create Estimate. This selection allows you to create a cost estimate for a task. The estimate is based on the employee hours (regular and overtime) and material items required to complete the task. Chapter 9 lists instructions for creating a cost estimate.

Calculate Unit Item Cost. This selection allows you to calculate the price to charge for an item in your inventory.

Help. This selection accesses the Help Menu. Help screens are available for:

- Work orders
- Entering material charge transactions
- Transaction form
- Restocking
- Backup/restore
- Numbers used
- Inventory
- Deleting an item
- Printing
- Kits
- Database structure
Chapter 3. Recording, Changing, and Deleting Task Information

This chapter includes detailed instructions for recording, changing, and deleting the basic task information required to maintain the Management Information System. Although on-screen instructions are provided for these functions, the operator should read this section and become familiar with all options available. In order to produce viable statistical reports from the program databases, basic information about each customer and task must be recorded. Once recorded, the operator can change or update the information as required. The program also updates the information each time you record material charges or labor against the work order number.

**Recording Task Information**

Use the Main Menu selection W to enter task information from task or work order forms prepared by employees. Follow the instructions listed below. Always note the instructions listed at the bottom of screens. The instructions provide information on continuing with the selected task and exiting.

1. At the Main Menu, press W. The first adding new task data entry screen will be displayed. To assist you in entering the correct work order number, the last work order number recorded and the date it was recorded is displayed at the bottom of the screen.

2. Type the new work order number in the WORK ORDER blank and press Enter. The program will check for duplicate work order numbers. If none are found, the second adding new task data entry screen will be displayed. Note instructions listed at bottom of screen.

3. Type information from task or work order forms in the blanks on the data entry screen. To record the task, you must enter information in blanks marked with an asterisk (CUSTOMER NAME, CUSTOMER ORGANIZATIONAL CODE, and current 10-digit JOB ORDER NUMBER). If you leave one of these blank, the task information will not be recorded. An operator message will be displayed. You can then choose to return to the data entry screen and correct the error or return to the Main Menu. You do not have to fill in other blanks at initial entry, but the information you record in them adds to the value of the statistical information maintained by the program.

   In the CUSTOMER blank, enter last name, followed by a comma, then the first name or initial. In the CODE blank, enter customer's organizational code. Enter the customer telephone extension in the blank marked X. Press Enter after each entry.

   In the CLASS blank, record the highest classification designation of the products being produced. If several items are being produced and only one of them is classified, enter the classification designation of that item. If you do not fill in this blank, an unclassified designation (U) will be recorded.

   In the CURRENT JO blank, enter the current 10-digit job order number that will be used for material billing. If any material will be used for this task, do not enter an element 11 job order. Those numbers are used for labor only.

   In the TITLE/KEYWORD blank, enter an identifying keyword or phrase for the technical content of the task. Normally, the project name is included in this blank. (Examples might be SURTASS viewgraphs, TID Logos, Torpedo Drag Reduction TD art, TR 345 hard-copy foldouts.)

   Enter START DATE, DUE DATE, and COMPLETE DATE if they are available.
In the COMMENTS blank, record any comments noted on the work order form or operator comments.

In the ILLUSTRATOR blank, record the initials of the primary illustrator. Separate labor information for five illustrators can be recorded against a task, but the initials of the employee who has primary responsibility for the task should be recorded in this blank. This is the primary illustrator. All other employees who record labor for the task will be recorded as secondary illustrators.

Note the PRODUCT and # blanks and the products listed in the box at the bottom of the screen. In order to track tasks by the type of work performed, the precise designation and quantity of products produced under a task must be recorded. The products listed at the bottom of the screen are the ones recorded during program setup (Setup Menu selection A). You do not have to fill in each PRODUCT blank. Record only enough products to adequately describe the work.

As discussed in chapter 1, costs are related to products. If you enter more than one product type, each time you record labor or material against the task you will have to select the product involved in that charge. If you record only one product, charges are automatically recorded against the one product. In the PRODUCT blanks, type only products listed at the bottom of the screen. If the product being produced is not listed, use Setup Menu selection A to add the product to the list of products.

If you type a product that is not listed at the bottom of the screen, the task information will not be recorded. An operator message will be displayed. You can then choose to return to the data entry screen and correct the error or return to the Main Menu.

If you do not type a product name at all, the product name, MISC (miscellaneous), will be recorded as the product name.

Type the number of NEW, REVISED, and RERUN products produced in the corresponding blank. If you are not sure of the number of products, don't worry. This information can be modified each time you record labor or material charges against the task.

4. When all applicable information has been entered on the data entry screen, press PgDn or Enter to exit the screen. A confirmation prompt will be displayed.

The information you entered will be displayed at the top of the screen. Your choices and instructions will be displayed at the bottom of the screen. If you have entered an element 11 job order number, an operator message will be displayed reminding you that the number can be used for labor only. It cannot be used to bill the customer for materials.

5. If the information is correct and you want to add the task information to the database, press Y. To return to the data entry screen and make changes, press R. To return to the Main Menu without adding the information, press X.

If you press Y at the confirmation prompt, the task information will be recorded. If you recorded a normal job order number, the Shop Store Billing Option Menu will be displayed. If you have entered an element 11 job order number, the Shop Store Billing Option will not be displayed. A reminder message will be displayed.
6. To record a material charge transaction against the task just entered, press B at the Shop Store Billing Option Menu. The first screen of a material charges data entry screen will be displayed. If you recorded more than one product for the task, you will be prompted to select the product for which the material was used. On the kit and inventory data entry screens, record kit and inventory items to be billed to the customer as described in chapter 4.

7. When all required information has been recorded, you can continue adding new task information or return to the menu. If you elect to continue adding new task information, the first adding new task data entry screen will be displayed. Return to step 2 above.

Changing (Updating) Task Information

Use the Main Menu selection U to update task information as required. Follow the instructions listed below.

1. At the Main Menu, press U. The locating task information data entry screen will be displayed. Note instructions displayed at the bottom of the screen.

2. Type the work order number, the customer name, or the customer code. You can locate the specific task by typing the full work order number or the full or partial customer name, or the customer's full or partial organizational code.

   If you enter the work order number, the program will find the task information, and the changing task data entry screen will be displayed.

   If you type the customer's full or partial name or organizational code, the program will search the database for all records with matching information. It will display detailed information about each match, and you will be allowed to select the information you need. For each match the program locates, the information and a menu will be displayed. You can access the displayed information, look for further matches, or stop looking and exit the function. When the required information is displayed, press Y to access the task.

   At the changing task data entry screen, previously recorded information will be displayed in the blanks. Note the instructions at the bottom of the screen.

3. At the data entry screen, use the arrow keys to position the cursor in the blank to be changed. Change information as required. Press Enter after typing changed information in the blank. To exit the screen, press PgDn. If you changed information, a confirmation prompt will be displayed. Press Y to record the changed information. Press R to display the data entry screen again. Press X to exit the function and return to the Main Menu.

   The second data entry screen allows you to change product names and numbers. A confirmation prompt will be displayed.

   Keep the following information in mind while you are updating task information.

   • You can change, but not delete, the following information: work order number, customer name, customer code, current job order number, and classification designation.
Only those products listed at the bottom of the product data entry screen will be accepted in the PRODUCT blanks. The initial product names are recorded at the Setup Menu. When adding products, you must record the product name and the number of product items in the corresponding blank. If you record the name without the number, one item will be listed in the NEW ITEM NUMBER column. If you record the number without the name, the product will not be recorded.

You cannot change the work order number to a number that is already listed in the database. If you attempt this, an operator message will be displayed. Any other changes you have entered will be recorded, but the work order number will not be changed.

If you change the primary illustrator designation, the new initials you enter must have been recorded during setup. You cannot record initials that have not previously been recorded at the Employee Options Menu.

If you try to delete or change information as discussed above, an operator message will be displayed. You can access the data entry screen again or exit without changing information.

If you change the current job order number to an element 11 job order number, you will not be able to bill the author for materials. A warning message will be displayed at the confirmation prompt before the job order number is changed.

When you exit the data entry screen, a confirmation prompt will be displayed. Press Y to change the task, X to return to the Main Menu, or R to return to the data entry screens. If you press Y, The Shop Store Billing Option Menu will be displayed. You can record material charges against the changed task if desired. Press B to access the applicable data entry screens.

When all required functions have been completed, an information screen and prompt will be displayed. Information on changes and transactions recorded will be displayed. You can continue changing information or return to the Main Menu.

**Deleting Task Information**

You can delete task information only if no customer costs have been recorded against the task.

To delete task information, press O at the Main Menu. The locating task information data entry screen will be displayed. Follow screen instructions to locate the task information.

When the task is found, note instructions displayed on the screen. If the task has not had charges against it, you will be prompted to confirm deleting the item. If the task has had charges against it, you can access it to mark it complete or change the completion date. You will be prompted to add or change comments as required. You can change the title/keywords to indicate that any charges were for preliminary work only.

**Marking Task Information Complete**

When you mark a task complete, you will be prompted to enter a completion date and finalize the product information related to the task. Statistical information concerning the products produced will be generated from the information recorded at completion.

Completion information can be recorded in several ways. You can enter completion information when you first record task information. You can select M at the Main Menu to enter the information. You can select U at the Main Menu and enter the information while changing other task information.
You can change the completion date and product information if you want to record materials or labor after the initial completion date has been recorded.

The finalizing product information data entry screen prompts for completion date and product information. The information shown on the screen has been recorded during initial entry, material billing, or labor recording. The unit cost shown is the cost per number of items recorded and reflects the customer's cost of all labor and material recorded. You will be able to modify the underlined items.

You can add products at this data entry screen, but you cannot add new charges to new products. Charges are recorded only when you record materials or labor against a work order number. You can change the names of products at this screen. If no products are recorded at initial task entry, MISC is recorded as product number 1.

As long as you do not delete all products, you can delete products that have had no charges recorded. To delete a product, remove the product name. The number of new, revised or rerun product items will automatically be deleted. If a product has had charges recorded against it, it cannot be deleted, but the product name and number can be changed if required. You cannot delete all products. If you delete all products, MISC will be recorded as product number 1.
Chapter 4. Recording, Changing, and Deleting Material Charges

This chapter includes detailed instructions for recording, changing, and deleting material charges. Although on-screen instructions are provided for these functions, the operator should read this chapter and become familiar with all options available. This chapter also includes information on locating task information and detailed descriptions of the data entry screens required for recording material charges.

A material charge bills a customer for materials. You can create a material charge to bill a customer after the customer's basic task information has been recorded. When you bill a customer, the material charge information is recorded by the program for later printing on a transaction form.

When you print the transaction form, each stock item or items you have billed will be listed as separate material charges on the form. You can change or delete a material charge at any time before the material charge information is printed on a transaction form.

Recording Material Charges

You can record a material charge against a task that has already been recorded or perform a procedure that allows you to record a new task and a material charge during the same operation. Instructions are listed below. Recording material charges involves locating existing task information or creating new task information, identifying products, and recording charge information at data entry screens. If you have set up kits as described in chapter 1, you can bill the customer for all items in a kit at the kit data entry screen. If many kits have been recorded, more than one kit data entry screen will be displayed. You can bill individual stock items at the inventory data entry screen. To record material charges, perform the procedure listed below.

1. At the Main Menu, press E. The locating task information data entry screen will be displayed. You can locate task information by work order number, customer name, or customer code.

2. Type the work order number and press PgDn. For other options, see Locating Task Information below.

3. At the identify product data entry screen, press the number corresponding to the product and press Enter. You can record material charges for any and all products that you have recorded as being produced under the work order number.

4. After the proper task information has been located and the product identified, data entry screens will be displayed. If you have recorded kits using setup, the kit data entry screen(s) will allow you to select kits to be charged to the customer. If you have not recorded kits during setup, the first data entry screen will be the inventory data entry screen. You can select items direct from the inventory to be charged to the customer.

5. At the kit data entry screen(s), record the number of kits used in production of the product in the applicable blanks and press PgDn.

6. At the Inventory data entry screen(s), record the number of inventory items used in production of the product and press PgDn.

7. At the confirmation prompt, press Y to confirm the order, N to ignore the order, or R to redo the material charge information.
8. You will be returned to the identify product data entry screen to allow you to record material charges for multiple products. Note the instructions displayed on the screen. To exit this screen and return to the Main Menu, press Esc.

Changing Material Charges

You can change the information in a material charge if it has not already been printed on a transaction form. Use the Main Menu selection C to change a material charge transaction. The locating material charge information data entry screen will be displayed. Record either the material charge control number, customer name, or work order number and press PgDn. The program will search for material charges matching the information you recorded. At each match found, you will be allowed to view the information and select or reject it as the applicable item to change. If the material charge has already been printed on a transaction form, an operator message stating that the item has been billed and cannot be changed will be displayed. When the applicable material charge transaction is found and selected, you will be able to change the material charge information on a data entry screen. Note that you cannot change a job order number to an element 11 job order number. If you attempt to do this, the job order number will not be changed. A message will be displayed.

Deleting Material Charges

You can delete the information in a material charge if it has not already been printed on a transaction form. Use the Main Menu selection D to delete a material charge transaction. The locating material charge information data entry screen will be displayed. Enter either the material charge control number, customer name, or work order number and press PgDn. The program will search for material charges matching the information you recorded. At each match found, you will be allowed to view the information and select or reject it as the applicable item to delete. If the material charge has already been printed on a transaction form, an operator message stating that the item has been billed and cannot be deleted will be displayed. When the applicable material charge transaction is found and selected, you will be able to delete the information on the material charge transaction. A confirmation prompt will be displayed. Press D to delete the item or X to exit without deleting.

Locating Task Information

You can locate a task by work order number or customer name.

Locating the Task by Work Order Number. At the locating task information data entry screen, enter the work order number for the material charge.

If the work order number is found, the kit and inventory data entry screens will be displayed. The product selection data entry screen will be displayed if the task involves more than one product. Follow instructions displayed at the bottom of the screen. At the kit and inventory item data entry screens, enter the number of kits and inventory items to charge against the work order number for the selected product. Press Enter after each number. Press PgDn or Esc to exit the data entry screen.

If the work order number is not found, a message will be displayed. Note instructions displayed on the screen. You can exit by pressing Esc. You can try again by re-entering the work order number. If you realize that this work order number has not previously been recorded, you can add the work order number by pressing PgUp.

26
If you press PgUp to add new work order number information, the task information data entry screens will be displayed. Record information as described in chapter 3. Each blank marked with an asterisk must be filled in. Type the work order number, customer's name (last name first), code, phone extension, classification, and job order number. Press Enter after each entry. Record the title or keyword, dates, comments, and product names as required. When the task information has been recorded, the kits and inventory data entry screens will be displayed. Follow instructions displayed at the bottom of the screen. Press PgDn or Esc to exit the data entry screen.

Locating Task Information by Customer Name. At the locating task information data entry screen, enter the customer's name and press Enter. Follow instructions displayed on the screen. If more than one product is listed under the work order, you will be prompted to select the applicable product at the product selection data entry screen. You will record material charge information at the kit and inventory data entry screens.

You can look up previously recorded customer information by typing a ? followed by the first few letters of the customer's name in the NAME blank and pressing PgDn. If you enter only a ?, a data entry screen will be displayed. You will be prompted to enter the customer's full or partial name, code, or the number of a previous material charge. The program will search for previously recorded information based on your entry. If you type a ? followed by the customer's full or partial name, the program will immediately search for previously recorded information based on the customer's name. If the program finds a matching name or partial name, the customer information will be displayed. You will be prompted to access the displayed information or continuing the search. You can exit at any time from this search feature.

If the program locates the proper task with correct name, code, and phone, but the job order number is not current, you can accept the name information, and correct the job order information at the next data entry screen.

Material Charge Data Entry Screens

When recording material charges, you will use data entry screens to locate or add the work order number, select the product for which the bill is required, and enter number of kits and/or inventory items for which to charge the customer.

Identify Product Data Entry Screen

When you record a material charge against a task that involves more than one product, you will be prompted to select the product for which the materials have been used. You can record material for as many products as are applicable to the task. At the identify product data entry screen, all applicable products will be listed. Press the number corresponding to the product and press Enter. If you have recorded only one product for the work order number, this data entry screen will not be displayed. Charges will automatically be recorded against the one product.

Kit Data Entry Screen

On the kit data entry screen, the kit name will be displayed along with the inventory part numbers and quantities that are included in the kit. A blank is positioned opposite each kit that has been recorded. Use the arrow or Enter key to position the cursor in the blanks opposite kits you provided to the customer. Record the number of kits to be recorded against the customer and job order listed at the top of the screen. You must press Enter after each blank you fill in.
If the customer information is not correct, press PgUp. The cursor will be positioned at the top of the screen where you can then make required changes.

If you press PgUp while recording a new transaction, the first data entry screen will be displayed.

When you have recorded numbers for each kit you provided to the customer, press PgDn to exit the kit data entry screen(s). The inventory data entry screen will be displayed.

**Inventory Data Entry Screen**

Each item you maintain in inventory stock will be displayed on the inventory data entry screen(s). If you have entered many inventory items, several screens will be displayed. For each item stocked, the stock number, description, unit of issue, unit cost, and number currently in stock will be shown.

To bill the customer for individual inventory items, position the cursor in the blank corresponding to the item to be billed, and type the number of items provided to the customer in that blank. Press Enter after each number you type. You can bill any number of any and all items listed as long as they are stocked. If an item is out of stock, a restock message will be displayed in the blank normally used for recording the number of items to bill.

If you press PgUp while recording a new transaction, the first data entry screen will be displayed.

When all required numbers have been entered, press Esc or PgDn to exit the data entry screen. If you press PgUp at the inventory data entry screen, you will be returned to the identify product data screen or the first kit data entry screen, depending on the number of products you have recorded for the task.

**Confirmation Prompt**

After you have entered the numbers for kits and stock items, a confirmation prompt will be displayed. Note information displayed on this screen. If a kit you billed contains a part that is currently out of stock, that information will be displayed. The parts that are out of stock will be displayed. You can bill currently stocked items, but those that are out of stock will not be billed. At the confirmation prompt, press Y to confirm the order, N to ignore the order, or R to redo the order.

NOTE: The program assigns a material charge control number to each material charge recorded. The material charge transactions you entered will not be recorded until you exit the data entry screens. You must press Y and at the confirmation prompt before the transactions are stored. Always note the operator messages.
Chapter 5. Recording Labor Information

This chapter lists the procedure for recording labor hours and costs. The Recording Labor function features detailed on-screen instructions. The procedure listed in this chapter gives more detailed information on options available.

Labor Hours and Costs

Labor hours can be recorded only for those employees whose labor rates have been recorded using the Setup Menu. Hours are recorded against specific products produced under specific tasks. If more than one product is listed, you can record hours expended against any product. Labor costs for a product are extrapolated from the number of hours recorded and the stored hourly rates for the employee. Regular and overtime labor hours can be recorded against the products listed for a task.

Recording Number and Type of Hours

Labor hours should be recorded each week. To record labor, perform the procedure listed in this chapter for each employee.

1. At the Main Menu, press L. The selecting employee data entry screen will be displayed. Initials and names for all employees are listed. If the employee is not listed, exit the labor function and use the Setup Menu to add the required employee information.

2. At the selecting employee data entry screen, type the initials of the employee. The locating matching information data entry screen will be displayed. Note instructions at the bottom of the screen.

3. At the locating matching information data entry screen, type the applicable full or partial work order number, customer name, or job order number and press Enter. The program will search for and display applicable information. Select the proper information and press Y. The entering product hours data entry screen will be displayed.

   The entering product hours data entry screen contains blanks for recording regular and overtime labor hours against the product. Blanks for each product you have recorded as applicable to the task will be displayed. Blanks for hours related to new products, revised products, and reprint products will be displayed under HOURS. Note that the number of product items is also displayed under NEW PRODUCT ITEMS, REVISED ITEMS, and RERUN ITEMS.

   You can change the product information at this time by pressing PgUp. A changing products produced data entry screen will be displayed. Read the instructions at the bottom of the screen. Four PRODUCT NAME blanks are available. Products and numbers already recorded are displayed. If no product name or number has been recorded, the product MISC will be displayed as product number 1.

   For any numbers recorded, there must be a corresponding product name. You can change the name and number of items of any listed product. Available product names are listed at the bottom of the screen. You can delete a product that does not have charges recorded against it. Products with charges recorded are marked with asterisks. If you attempt to delete a product with charges already recorded, or type an erroneous product name, an error message will be displayed. You can exit this screen and return to the entering product hours data entry screen by pressing PgDn or Esc.
4. Position the cursor in the proper blanks and type the number of regular hours and/or the number of overtime hours to be recorded and press Enter. If you are backing out hours, enter a minus sign before the number.

   A completion prompt will be displayed. If the task is complete, type the completion date in the completion date blank.

5. A confirmation prompt will be displayed. To confirm the hours, press Y. A Continuation Menu will be displayed. Note choices. To continue recording labor for the current employee, press C. To record labor for another employee, press N. To exit, press X.

   If you press N, return to step 2.

   If you press C, return to step 3.

   If you press X, and the print labor option has been selected at the Printer Options Menu, the Print Labor prompt will be displayed. To print the labor information just recorded, press Y and press Enter.

**Backing out Hours**

To back out erroneously recorded hours, type negative numbers (numbers preceded by a minus sign) in the HOURS blanks.
Chapter 6. Viewing Information

Information That Can Be Viewed

Use the View Menu to view task information, material charge transactions, and inventory information. You can also use the Inventory Check Menu to view inventory information. You can view employee information and sales information.

Viewing Task Information

At the Main Menu, press V. The View Menu will be displayed.

To view task information by customer, code, or work order number, press W. The locating task information data entry screen will be displayed. Note instructions displayed at the bottom of the screen. You can locate tasks by customer, code, or work order number. Type the full or partial customer name or code, or the full work order number. The program will locate each applicable item and display brief information on the screen. Note the choices displayed at the bottom of the screen. To access the information for more detailed viewing, press Y. To continue viewing brief information according to your search, press N. To exit, press X. If you access the information for a more detailed look, the following information, if recorded, will be displayed:

- work order number
- classification
- customer name, code, and telephone extension
- all job order numbers used, dates assigned, and total charges
- project title
- shop store charges
- illustrator names, dates assigned, hours, and customer costs
- date first labor was recorded
- project start and completion dates
- comments
- products produced
- total customer cost to date

To view task information by job order number, press J at the View Menu. You will be prompted to enter the full or partial job order number. A screen showing detailed information will be displayed for each task with matching job order number information.
To view task information by employee labor (employee who has worked on a task), press E at the View Menu. The selecting employee data entry screen will be displayed. All available employees and their initials will be displayed. Type the initials of the employee. A screen showing detailed information will be displayed for each task that employee has charged against.

**Viewing Material Charges**

At the Main Menu, press V. The View Menu will be displayed.

At the View Menu, press L.

At the Viewing Material Charges Menu, press O to view one material charge, A to view all material charges, or S to view selected material charges.

If you press O to view one material charge, the locating material charge information data entry screen will be displayed. Note instructions at the bottom of the screen. Enter the full or partial customer name or code or the full material charge control number to initiate a search for the material charge. Each material charge matching the information you entered will be displayed.

If you press A to view all material charges, information for all items will be displayed in numerical order. You can press Esc at any time to return to the previous menu.

Press S to view selected material charges. The Viewing Selected Material Charges Menu will be displayed. You can view selected material charges by customer name, code, or job order number, by transaction form number, by date entered, or by portion of the work order number. You will be prompted to enter the information required for the search. When all matching items have been displayed, you will be returned to the Viewing Selected Material Charges Menu. The number of material charges viewed will be displayed at the bottom of the screen. To return to the Viewing Material Charges Menu, press X.

**Viewing Inventory Information**

At the View Menu, press S. The inventory information screen(s) will be displayed. The material you currently have in stock will be displayed. The stock number, name, unit of issue, unit cost, and number of items in stock will be shown for each item. After all items have been displayed, a screen showing items currently out of stock will be displayed.

You can also use the Check Inventory selection at the Main Menu to view stocked items. At the Main Menu, press I. At the Inventory Check Menu, press V to view inventory items.

**Viewing Kit Information**

You can view kit information at the View Menu or the Inventory Check Menu. At the View Menu or the Inventory Check Menu, press K. The kits you have set up will be displayed. The kit name and the stock number and name and quantity of each item in the kit will be shown.
Viewing Sales by Stock Number

You can view the total number of sales of each item stocked. At the View Menu, press P. Note instructions at the bottom of the data entry screen. Type the full or partial stock number in the first blank. To count only those items appearing on a single transaction form, enter the form number in the second blank. To include only items recorded after a specific date, enter the date in the second blank. Note that you can retrieve the information by form number or date, not both. After your selections have been made, an information screen showing the number of items counted and the individual stock numbers included in the count. This function is also available at the Inventory Check Menu.

Viewing Archived Forms

When you print a transaction form, basic accounting information for each material charge is written to a text file. You can view this archived transaction form information if required. At the View Menu, press T. The Archive View Choices Menu will be displayed. Press L to view the last original or duplicate form printed. Press A to view all forms that have been printed. Note the instructions displayed at the beginning of the file. If the display takes more than one screen, press the space bar to scroll to the next screen. Press Q to quit at any time. When the entire file has been displayed, you will be prompted to press Enter.

Checking the Inventory

Main Menu selection I (Check Inventory) allows you to view inventory information. At the Inventory Check Menu, press I to display inventory items that are out of stock. Press V to display the inventory list. Press T to display a list of transaction forms that have not been printed. Press K to display kit information. Press C to check the kits for problems with out-of-stock parts. Press S to count sales of one stock item.

Viewing the Customer List

To view a list of customers, press C at the View Menu. The Viewing Customer List Menu will be displayed. You can view all or selected customers.

To view information on all customers, press A. For each customer, a screen showing customer name, code, phone, and job order number used will be displayed. Note instructions displayed at the bottom of the screen. Press Enter to browse through the list. Press Esc to return to the menu.

To view information on selected customers, press S. You will be prompted to enter the customer's full or partial name or the customer's full or partial code. The customer name, code, phone, and job order number will be displayed for each match found.

Viewing Employee Information

You can view employee information from the View Menu or the Setup Menu. To view employee information from the View Menu, press I at the View Menu. To view employee information from the Setup Menu, press E at the Setup Menu and then V at the Employee Options Menu. The View Employee Information Menu will be displayed.
To view information on one employee, press 0 at the View Employee Information Menu. The employee information data entry screen will be displayed. You will be prompted to enter the initials of the employee. All available initials and names will be displayed for your selection. Type the employee initials and press Enter. The employee last name, first name, title, overhead and project rates, and employment status will be displayed.

To view information on all employees, press A at the View Employee Information Menu. A separate screen will be displayed for each employee. The employee last name, first name, title, overhead and project rates, and employment status will be displayed. Note instructions at the bottom of the screen. Press Enter to continue viewing. Press Esc to return to the menu.

**Viewing Statistics**

You can view or print product statistical information from the Statistical Information Menu. At the View Menu, press G. The Statistical Information Menu will be displayed. Because time, cost, and labor information cannot be considered final until a task is complete, only completed task information is examined for inclusion in the statistical reports. You can view or print information by organizational code, job order number, or illustrator.

All selections allow you to restrict information to products produced under tasks recorded between two dates. If accessing information by organizational code, you can also restrict information to products produced for a particular organizational code. If accessing information by job order number, you can restrict information to products produced under one or several job order numbers. If accessing information by illustrator, you can restrict information to products produced by a particular code, and also to those tasks where an illustrator is the primary or secondary illustrator.

If you are accessing information by organizational code or job order number, statistical information will be provided for a specific product, so you must enter a product name. If accessing information by illustrator, you do not have to enter a product name, but the information will be more detailed if you do.

Statistical information includes the number of products produced, the total cost to the customer, and the unit cost to the customer.
Chapter 7. Printing Information

Before You Print

The Setup Menu Printer Control option allows you to select the computer printer output port and the type of printer you are using. At the Setup Menu, press P. The Printer Options Menu will be displayed.

At the Printer Options Menu, you can select an Epson dot matrix or an HP Laserjet printer emulation. For an HP emulation, press H. For an Epson emulation, press E.

Check the PC printer port. At the Printer Options Menu, press the port selection (1, 2, 3, or 4) corresponding to your setup. If you select a printer port that does not have a printer attached, the messages TURN PRINTER ON TO CHECK STATUS and PRINTER NOT READY will be displayed. If the printer port has been correctly selected and that message is displayed, check that the printer is on-line and that the cable is securely attached.

Toggle the Print Labor Option ON if you want a printout of labor hours as you record them.

The Print Menu

The Print Menu allows you to print task and transaction information. To access the Print Menu, press P at the Main Menu. The Print Menu will be displayed. Print choices are also available at the Transaction Forms Menu, the Inventory Check Menu, and the Employee Options Menu. The Print Menu is shown in figure 3.

<table>
<thead>
<tr>
<th>TASK PRINT CHOICES</th>
<th>SHOP STORE PRINT CHOICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>O - ONE TASK</td>
<td>T - TRANSACTION FORMS</td>
</tr>
<tr>
<td>P - TASKS BY CUSTOMER</td>
<td>CURRENT FORM IS # _</td>
</tr>
<tr>
<td>C - TASKS BY CODE</td>
<td>S - INVENTORY STOCK LIST</td>
</tr>
<tr>
<td>J - TASKS BY JO NUMBER</td>
<td>K - KIT LIST</td>
</tr>
<tr>
<td>G - STATISTICS</td>
<td>L - SELECTED MATERIAL CHARGES</td>
</tr>
<tr>
<td>H - PRODUCT COST/TIME AVERAGES</td>
<td>A - ALL MATERIAL CHARGES</td>
</tr>
<tr>
<td>N - TASKS WITH NO CUSTOMER COSTS</td>
<td></td>
</tr>
<tr>
<td>I - TASKS BY ILLUSTRATOR</td>
<td></td>
</tr>
</tbody>
</table>

X - EXIT ? - HELP

CHOICE ?

PRINTER READY

Figure 3. Print Menu.
**Task Print Choices**

You can print task information by individual work order number, customer, organizational code, or job order number.

**One Task**

Press O to print detailed information on one task. The locating task information data entry screen will be displayed. Note instructions displayed at the bottom of the screen.

Type the work order number, customer name, or customer code. You can locate the specific task by typing the full work order number, the full or partial customer name, or the customer’s full or partial organizational code.

If you enter the work order number, the program will find and print the task information.

If you type the customer's full or partial name or organizational code, the program will search the database for all records with matching information. It will display information about each match, and you will be allowed to select the information you need. For each match the program locates, the information and a menu will be displayed. You will be allowed to access the displayed information, keep looking for further matches, or stop looking and exit the function. When the information for which you are searching is displayed, press Y to access the task and print the information.

**Tasks by Customer**

At the Print Menu, press A to print a list of all tasks from an individual customer. At the data entry screen, type the customer’s full or partial name and press Enter. If you enter a partial name, such as SMITH, information on all tasks from all customers with SMITH in their names will be printed. To narrow the selection, type enough of the customer’s name to ensure that only tasks from that customer will be included.

**Tasks by Code**

At the Print Menu, press C to print a list of all tasks from an individual organizational code or a list of all items listed numerically by organizational code. At the data entry screen, type the code or the word all and press Enter. If you type a code, you will be prompted to enter whether or not you want to include also all codes organizationally located under that code.

**Tasks by Job Order Number**

At the Print Menu, press J to print a list of items by job order number. The Job Order Print Choices Menu will be displayed.

Selection F allows you to include one job order only or job orders containing common digits located anywhere within the job order number. If you want to print a list of all tasks using job order numbers that contain the digits ‘111,’ use selection F.

Selection W allows you to include job orders that begin with the same digits. If you want to print a list of all tasks that have used job order numbers starting with ‘796110,’ then choose selection W.
Statistics

You can view or print product statistical information from the Statistical Information Menu. At the Print Menu, press G. The Statistical Information Menu will be displayed. Because time, cost, and labor information cannot be considered final until a task is complete, only completed task information is examined for inclusion in the statistical reports. You can view or print information by organizational code, job order number, or illustrator.

All selections allow you to restrict information to products produced under tasks recorded between two dates. If accessing information by organizational code, you can also restrict information to products produced for a particular organizational code. If accessing information by job order number, you can restrict information to products produced under one or several job order numbers. If accessing information by illustrator, you can restrict information to products produced by a particular code, and also to those tasks where an illustrator is the primary or secondary illustrator.

If accessing information by organizational code or job order number, statistical information will be provided for a specific product, so you must enter a product name. If accessing information by illustrator, you do not have to enter a product name, but the information will be more detailed if you do.

Statistical information includes the number of products produced, the total cost to the customer, and the unit cost to the customer.

Product Cost/Time Averages

You can print lists of products with customer cost totals and averages for products. You can restrict the listings to include only tasks from specific organizational codes or tasks recorded within a specified time period. You can restrict the list to include only completed tasks. You can configure this report in several other ways as well.

Tasks with no Customer Costs

You can print a list of tasks that have had no material charges recorded or a list of tasks that have had no labor charges recorded.

Tasks by Illustrator

You can print lists of tasks by illustrator for any or all products.

Shop Store Print Choices

The Print Menu allows you to print

- Transaction forms
- Inventory stock list
- A kit list
- Selected material charge transactions
All material charges recorded (in various orders)

You can also print selected shop store information from the Transaction Forms Menu and the Inventory Check Menu.

Printing Transaction Forms

At the Main Menu, press T to access the Transaction Forms Menu. The current form number will be displayed at the top of the screen. The current form lists the most recent material charge transactions. Chapter 8 contains detailed information on the Transaction Forms Menu.

Printing a Draft of a Transaction Form. Before you print the current transaction form for sending to accounting, press D at the Transaction Forms Menu to print a draft copy. Recheck material charges and correct billing mistakes before you print the form that will be sent to accounting.

Printing the Actual Transaction Form. At the Transaction Forms Menu, press P to print a transaction form for sending to accounting. You will be prompted to enter the form number to print. A confirmation prompt will be displayed. The screen displays information on whether the form has been previously printed or not. If the form has not been printed before, it will be marked original when printed and should be sent to accounting. If it has been printed before, it will be marked duplicate. When an original form is printed, the next number in sequence is automatically applied to future material charge transactions that you enter. Always print a draft (selection D) of the transaction form before you print the actual form.

Printing the Inventory Stock List

The inventory stock list lists all items you have in stock. You can print the inventory stock list from the Print Menu or the Inventory Check Menu. Press S at the Print Menu or P at the Inventory Check Menu to print the list. It will list item stock number, name, unit of issue, and number in stock for each item in the inventory. A list of items that are currently out of stock will be printed at the bottom of the inventory list.

Printing the Kit List

Press K at the Print Menu to print a list of kits. The list shows kit names and the stock number and name and quantity of inventory items contained in each kit.

Printing a List of Material Charges

Selected Material Charges. Press L at the Print Menu to print a list of selected material charge transactions. The Printing Selected Material Charges Menu will be displayed. You can print the list of material charges for any customer name, code or job order number, or by transaction form number or date entered. You will be prompted to enter information for the program search. The printout will list material charge control number, stock number, item name, unit of issue, quantity, unit cost, total amount, customer, customer code, date entered, job order number, transaction form number, and transaction form date for all material charge transactions that match the search.

All Material Charges. Press A at the Print Menu to print a list of all material charge transactions in various orders. You can print by customer name, code, or job order number. You can also print in order of transaction form number or stock item name. These lists will be extremely long. You'll need a lot of paper.
Chapter 8. Transaction Forms

This chapter describes the Shop Store transaction form and includes instructions for processing the form. The transaction form functions are designed with on-screen instructions. This chapter lists more detailed instructions for using the functions.

What is the Transaction Form?

The transaction form is created from information stored each time you bill a customer for material. Because consecutive numbers are assigned to the forms and stored with the billing information, the MIS can identify, display, and print a list of charges that appear on a specific forms. When you print the transaction form, each item assigned to a specific form number will be listed as a material charge on the form. The form is signed by the supervisor and sent to accounting for processing. Accounting ensures that the individual charge amounts listed on the transaction form are transferred from the customer’s account to the shop store account.

The Transaction Forms Menu

Press T at the Main Menu or the Print Menu to access the Transaction Forms Menu. The Transaction Forms Menu will be displayed. You can check for transaction forms that have not been printed, view the items that appear on any transaction form, or print a transaction form. The Transaction Forms Menu also displays the number of the current form in use. This is the form that will list the latest material charge transactions.

Checking for Transaction Forms That Have Not Been Printed

Press C at the Transaction Forms Menu to check for forms that have not been printed. A transaction form message will be displayed. Transaction forms are numbered sequentially. Numbers of forms that have not been printed will be displayed.

Viewing Transaction Forms

Press V at the Transaction Forms Menu to view the information listed on a transaction form. You will be prompted to enter the number of the form. All information that appears on that transaction form will be displayed for each material charge transaction on the form. Customer information, stock information (including stock number, unit of issue, quantity, unit cost) job order number, and date of entry will be displayed for each material charge transaction. If the form has not been printed, the message NOT BILLED YET will be displayed at the top of the screen. If the form has been printed, the date of print will be displayed at the top of the screen.

Printing a Draft of a Transaction Form

Press D to print a draft copy of a transaction form. It is a good idea to print a draft before you print the actual form that will go to accounting. This will allow you to recheck material charges and correct billing mistakes before the actual transaction form is printed.
Printing a Transaction Form

Press P to print a transaction form. You will be prompted to enter the form number to print. A confirmation prompt will be displayed. The screen displays information on whether the form has been previously printed or not. If the form has not been printed before, it will be marked *original* when printed and should be sent to accounting. If it has been printed before, it will be marked *duplicate*. When an original form is printed, the next number in sequence is automatically applied to future material charge transactions that you enter. Always print a draft (selection D) of the transaction form before you print the actual form.

Archived Forms

When you print a transaction form, basic accounting information for each material charge is written to a text file. You can view this archived transaction form information if required or copy it to a floppy disk.

Viewing Archived Forms

At the View Menu, press T. The Archive View Choices Menu will be displayed. Press L to view the last original or duplicate form printed. Press A to view all forms that have been printed. Note the instructions displayed at the beginning of the file. If the display takes more than one screen, press the space bar to scroll to the next screen. Press Q to quit at any time. When the entire file has been displayed, you will be prompted to press Enter.

Copying Archived Forms to Floppy Disk

You can copy the archived transaction form information from your hard disk to a formatted floppy disk if required. At the Transaction Forms Menu, press E. Follow instructions displayed on the screen. The file created is an ASCII file and can be used with a word processing program.

Removing Archived Forms

You can delete the archived transaction form information from your hard disk if required. At the Transaction Forms Menu, press R. Copy the archived form to floppy disk (selection E) before you remove it.
Chapter 9. Creating a Cost Estimate

What is a Cost Estimate?
A cost estimate displays the projected customer cost of a task based on your estimate of the hours and material required to produce the products for that task. The estimate includes the cost for work by up to five employees and the cost for as many stocked items as the task requires. The cost estimate can be viewed and printed.

Creating a Cost Estimate
To create a cost estimate, press Q at the Main Menu. The creating cost estimate data entry screen will be displayed. Note the on-screen instructions displayed at the bottom of the screen.

At the creating cost estimate data entry screen, type the customer name and the type of job order number (project or overhead) to be used and press Enter. The selecting employees for estimate data entry screen will be displayed. All available employees and their initials will be displayed.

At the selecting employees data entry screen, type the initials of the first employee and press Enter. Labor hour prompts will be displayed below the employee initials. Type the number of regular hours and overtime hours to be worked and press Enter. The employee's initials will be displayed at the bottom of the data entry screen. You can enter up to five different employee initials and hours on each estimate. Continue recording employee initials and hours as required. When you have entered all required employee initials, press PgDn or Esc to exit the selecting employee data entry screen. The available kit data entry screen will be displayed.

Type the number of each kit required in the applicable blanks and press Enter. Press PgDn to exit the screen. The inventory items data entry screen will be displayed.

Type the number of each stock item required in the applicable blanks and press Enter. Press PgDn to exit the screen. A confirmation prompt will be displayed. Note instructions displayed on the screen. Press Y to display the completed estimate. To print the estimate, press P.
Chapter 10. Backup and Restore

What You Will Need

The Backup/Restore option allows you to back up the database files used in the program to disks in drive a or b or restore backed up files to current use. The program uses the DOS backup utility to allow long files to be written over several disks. You must have a formatted floppy disk available to back up the files. You can use the same backup disks over and over. Each time you back up your files, mark the disks with the date of backup.

Backing Up Files

To back up files, press B at the Setup Menu. An information and instruction screen will be displayed. Read the text displayed and press Enter. The Backup/Restore Menu will be displayed.

To back up files, press A or B at the Backup/Restore Menu. This selection indicates which floppy disk drive you will be using for the backup disks. The DOS Backup utility will be called. Follow instructions displayed on the screen. The databases holding administrative information as well as those holding information on inventory, kits, tasks, customers, employees, and material charge transactions will be backed up. The file names will be displayed as they are backed up. If you have recorded many tasks and material charge transactions, the files can be quite large. You will require several disks. Use large-capacity or high-density disks for backup operations. The program will prompt you to insert disks as required. When the backup operation is complete, you will be prompted to press Enter.

Restoring Files

Backed-up files should be restored only if the current files residing on the hard disk have been damaged or destroyed beyond retrieval. The backed up files contain information recorded before the last backup date. Any information recorded since that date will not be recorded on the backup disks.

To restore files, press R or S at the Backup/Restore Menu. This selection indicates which floppy disk drive you will be using. An operator message will be displayed. You will be asked to confirm the restore operation. If you confirm by pressing R, the current files will be saved and then the DOS Restore utility will be called. Follow instructions displayed on screen. All current databases will be replaced by those on the backup disks. The file names will be displayed as they are restored. When the restore operation is finished, you will be prompted to press Enter.

Some current database files are saved to different file names before a restore operation. To retrieve files overwritten by the restore operation, you can delete the current database files and rename the saved files as follows:

<table>
<thead>
<tr>
<th>Saved file name</th>
<th>Current file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>c:\shopstor\oldemp.sav</td>
<td>c:\shopstor\employee.dbf</td>
</tr>
<tr>
<td>c:\shopstor\oldres.sav</td>
<td>c:\shopstor\resource.dbf</td>
</tr>
<tr>
<td>c:\shopstor\oldgrmis.sav</td>
<td>c:\shopstor\grmis.dbf</td>
</tr>
<tr>
<td>c:\shopstor\oldshop.sav</td>
<td>c:\shopstor\shop.dbf</td>
</tr>
<tr>
<td>c:\shopstor\oldcont.sav</td>
<td>c:\shopstor\miscont.dbf</td>
</tr>
<tr>
<td>c:\shopstor\oldinven.sav</td>
<td>c:\shopstor\inven.dbf</td>
</tr>
</tbody>
</table>
Chapter 11. Database Administrator

Functions

Limited functions are available at the Database Administrator Menu. The Database Administrator function is password protected. These functions are not normally performed by the operator. The following functions are available.

Start New Transaction Form

This function is not normally selected or used. The MIS/Shop Store Program numbers the transaction form numbers as required.

Each transaction form is numbered (starting with 1). All material charge purchases you record will appear on this form until you print the form. When you print the form, the program checks to see if it is the first time that the form has been printed. If it is, then the computer assigns the next number in sequence to the next transaction form. The next material charge transactions will appear on the form with the new number. If you print a duplicate of a transaction form, the program does not change the number.

If you use the Start New Transaction Form selection, the form number is increased by one, but the previous form is not printed. The form number will again be increased when you print the form. This selection is used only if you must begin a new transaction form without printing the current form.

Reinitialize Transaction Form

This selection removes the form date information from selected material charges. It allows you to reprint an original form as an original form.

The form date information is written to the database record when an original transaction form is printed. For example, when you choose to print transaction form number 1, each material charge transaction planned for printing on form number 1 is marked with the current date. If there is a date in that material charge transaction record field, the program can identify that the form has been already been printed as an original.

You can reinitialize the date field to zero for all material charge transactions assigned to any form number. Do not do this if the form has already been sent to accounting.

Re-index Databases

Re-indexing is not normally required. The program maintains the databases indices. Re-index only after extensive manual database manipulation.

Program Control Databases

These selections allow you to edit the controlling databases containing administrative, inventory, kit, and employee information.
Print Database Structure
This selection prints the database structure information to your printer.

Check for Product Errors
This selection checks the database for outdated product names.
Index

A

account
  contra account, 9
  shop store job order number, 4
  tracking shop store account numbers, 5
accounting, 1, 4, 5, 9, 25, 38
  viewing material charge accounting information, 33
add new task information, 19

C

cost
  calculating unit cost, 10, 17

customer
  billing a customer for materials, 4
  changing customer information, 16, 21
  costs, 3, 4, 34
  exact costs, 4, 11
  list, 33
  locating by customer, 8
  locating information by customer, 27, 36
  material charge details, 5
  printing by, 36
  printing by customer, 36
  required information, 19
  viewing by customer, 31, 32
customer list
  printing, 38
  viewing, 33

D

data entry screen

adding employee, 12
adding new task, 19
administrative information, 9
changing employee information, 12
changing material charge, 26
changing products produced, 29
changing task, 21
creating cost estimate, 41
definition, 8
deleting employee information, 12
employee information, 13, 34
entering information for material charges, 21
entering product hours, 29
finalizing product information, 23

E

editing database files, 45
employee
  changing employee information, 12
deleting employee information, 12
labor print option, 15
labor rates, 12, 30
printing employee information, 13
productivity, 2
recording employee labor, 29
recording information, 12
required information, 12
viewing employee information, 12, 33
errors
  checking for inventory errors, 16
  employee information, 12
kit, 11
  product, 20, 29, 46
stock, 10
task information, 19

F
FoxPro, 1, 6, 14, 15

I
illustrator
  changing, 22
  labor hours, 3
  primary, 15, 20
  printing illustrator statistics, 37
  printing tasks by illustrator, 37
  secondary, 20
  viewing illustrator statistics, 34
instructions
  on-screen, 7
inventory
  definition, 5
  entering stock, 10

J
job order
  billing for stock loss, 11
  changing, 22, 27
  deleting, 21
  element 11 job order number, 19, 20, 22
  entering job order number, 19
  job type for estimates, 41
  locating information by job order number, 8
  overhead job order number, 11
  printing by, 36, 38
  shop store job order number, 4, 9, 11
  viewing by, 17, 31, 32, 39
  viewing statistics by, 34
job order number
  shop store, 4

K
kits
  and stock numbers, 12
  changing for, 26
  checking, 16
  definition, 10
  displaying kit information, 33
  errors, 28
  in setup, 4
  items in kits, 11
kit data entry screen, 28, 41
kit database, 45
Kit Option Menu, 12
material records recorded, 16
names for kits, 11
printing the kit list, 38
setting up, 8
viewing, 17
viewing kit information, 32

L
labor
  as part of customer costs, 23
  as related to products, 3, 20
  deleting information, 19
  employee labor rates, 13
  first labor recorded, 31
  job order numbers, 19
  labor as statistical information, 37
  labor for multiple illustrators, 20
  labor information as statistical data, 34
  labor print option, 13, 35
  recording after completion date, 23
  recording labor information, 3, 15
  viewing by employee labor, 32

M
material charge
  backing up, 43
  by product, 27
  changing, 16, 26
  control number, 28
  definition, 5, 25
  deleting, 16, 25, 26
  entering new, 16
  printing, 16, 38
  recording, 21, 22, 25
  sequence, 9
  transaction form, 39
  viewing, 32
menu
  archive view choices, 33, 40
  backup/restore, 43
  database administrator, 13, 45
  employee functions, 12
  employee options, 22
  help, 17
  instructions for using menus, 7
  inventory check, 16, 31, 32, 33, 38
  job order print choices, 36
  kit option, 12
  main, 4
  main menu access, 15
  main menu choices, 15
  print, 5, 17, 35, 38
  printer control, 13
printer options, 30, 35
setup, 3, 4, 6, 8, 14, 17, 35
shop store billing option, 20
statistical information, 34, 37
transaction form, 38, 39
transaction forms, 16
view, 17, 31
view employee information, 12, 33
viewing customer list, 35
viewing material charges, 32
viewing selected material charges, 32
MIS, 1

N

new product, 3
number
contra account, 9
current transaction form, 9
material charge, 9
of products, 3
of tasks, 15
transaction form, 5
work order, 3

P

price
calculating price to charge for material items, 17
defined, 10
displaying price of material items, 16
listed on material charge, 5
price paid for material, 11
price-per-item, 11
printing unit price information, 38
recording price of stock items, 4
unit price and unit cost, 11
viewing unit price information, 32
print
by customer, 36
cost estimate, 41
employee information, 13
incrementing transaction form number, 45
inventory list, 16
inventory stock list, 38
kit list, 38
labor information, 15
list of transaction form numbers, 16
material charges, 38
menu, 17
print labor option, 13, 30, 35
print labor prompt, 30
print menu, 35
print options menu, 30
print statistical information, 34
printer control, 35
printer control menu, 13
printer emulation, 13, 35

print not ready, 13, 35
printer port, 13, 35
reinitialized transaction form, 45
statistics, 37
task choices, 36
tasks by code, 36
tasks by job number, 36
transaction form, 4, 5, 16, 40
transaction form draft, 38, 39
transaction forms, 38, 39
printing database structure, 46
product
changing, 21, 23, 29
classification, 19
cost/time average reports, 37
definition, 3
deleting, 23
entering product hours data entry screen, 29
errors, 46
identify product data entry screen, 27
initial information, 9
master list, 9, 11
multiple products and material charges, 27
outdated product name, 11
printing product statistics, 37
product selection, 26
recording, 20
recording labor against, 29
types, 3, 9
viewing statistics, 34

R

rerun product, 3
restock
restock message, 28
when to restock, 10, 28
revised product, 3

S

statistics, 37
and completion information, 22
value, 19
viewing, 17, 34
stock
calculating actual cost, 4
entering initial stock information, 8
entering stock required for estimate, 41
limit on number of stocked items, 4
name, 5, 10
number, 10
number of items in stock, 10
ordering, 4
out-of-stock items, 16
out-of-stock items on material charges, 28
printing stock list, 38
purchasing, 1
stock information in kits, 10
stock items in kits, 4
stock items listed on material charge, 25
stock loss, 11
stock number, 11
stock numbers, 4
viewing, 32, 33
viewing stock information, 39
stock number
stock, 11

T

task
changing, 21
definition, 2
deleting, 15
entering, 15, 19
marking complete, 22
updating, 15, 21
viewing, 31
transaction form
check/view/print, 16
checking, 16
conna account number, 9
current number, 9, 15
definition, 5
duplicate, 16
number, 16
re-initializing, 14
signature, 9
viewing, 17

U

unit cost, 2, 10, 17, 23, 34, 37
definition, 5
unit price
definition, 5

V

view
archived forms, 33, 40
cost estimate, 41
employee information, 12, 33
inventory information, 16, 32, 33
kit information, 16
kits, 32, 33
list of transaction forms, 33
material charges, 32
out-of-stock items, 33
out-of-stock parts, 33
sales, 33
sales by stock number, 33
statistics, 34
task information, 33
transaction form, 39

W

work order number
change to duplicate, 22
delete, 21
description, 3
duplicate, 19
enter, 19
enter material charge, 16
locate information by, 21
record, 19
view by, 17
when charges are recorded, 23
This manual provides instructions for the Management Information System (MIS)/Shop Store Program.

The MIS/Shop Store Program maintains records of graphics work, provides statistical information on that work, and facilitates the use of a small shop store at NCCOSC's RDT&E Division (NRaD). It consists of application programs running within the FoxPro 2.5 database program and is used in a group that produces graphics products at NRaD. The program features on-screen instructions that lead the operator through most routine tasks associated with the MIS and shop store functions.
<table>
<thead>
<tr>
<th>Sr. NAME OF RESPONSIBLE INDIVIDUAL</th>
<th>Sr. TELEPHONE (Include Area Code)</th>
<th>Sr. OFFICE SYMBOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>E. B. Reediff</td>
<td>(619) 563-4766</td>
<td>Code 02701</td>
</tr>
</tbody>
</table>
INITIAL DISTRIBUTION

Code 0012    Patent Counsel        (1)
Code 0274    Library               (2)
Code 0275    Archive/Stock         (6)
Code 027    M. E. Cathcart         (45)
Code 02701  E. Ratliff             (5)

Defense Technical Information Center
Alexandria, VA 22304–6145

NCCOSC Washington Liaison Office
Washington, DC 20363–5100

Center for Naval Analyses
Alexandria, VA 22302–0268

Navy Acquisition, Research and Development
Information Center (NARDIC)
Arlington, VA 22244–5114

GIDEP Operations Center
Corona, CA 91718–8000